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Preface

Purpose

This guide provides information about installing and upgrading Cisco Unified Customer Voice
Portal (Unified CVP) components, and discusses procedures for performing related component
and deployment migrations.

Audience

This guide is intended for the Network Administrator who plans to install or upgrade Unified
CVP software.

Organization

This guide consists of the following sections:

DescriptionSection

Provides an overview of the Unified CVP
installation procedure and discusses what is

Chapter 1: Planning Your Unified CVP
Installation (page 5)

and what is not within the scope of this
procedure.

Discusses the procedures that you must perform
prior to installing Unified CVP software.

Chapter 2: Performing Pre-Installation Tasks
(page 14)

Describes how to install Unified CVP software
on Windows 2003 systems.

Chapter 3: Installing Unified CVP (page 19)

Describes how to install Unified Call Studio
software on Windows XP and Vista.

Chapter 4: Installing Unified Call Studio (page
27)
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DescriptionSection

Discusses tasks you must perform after
installing Unified CVP Software.

Chapter 5: Post Installation Tasks (page 29)

Describes the procedures for removing Unified
CVP software components.

Chapter 6, Uninstalling Unified CVP Software
(page 35)

Discusses the Unified CVP solution
components and versions.

Chapter 7, Understanding CVP Solution
Upgrade Compatibility (page 39)

Discusses the procedures that you must perform
prior to upgrading to CVP 8.0(1).

Chapter 8: Planning Your CVP Upgrade (page
49)

Discusses the tasks and procedures for
upgrading from a previous release of the

Chapter 9, Upgrading to CVP 8.0(1)
Components (page 49)

product to Unified CVP Release 8.0(1) and for
performing related component and deployment
migrations.

Discusses the tasks and procedures for
performing related component and deployment
migrations.

Chapter 10, Performing CVP Solution
Migration (page 61)

Describes how to resolve problems that you
may encounter when installing, upgrading, or
removing Unified CVP software.

Chapter 11, Troubleshooting Unified CVP
Software Installation (page 65)

Related Documentation

Note:  Planning your Unified CVP solution is an important part of the process in setting up
Unified CVP. Cisco recommends that you read the Cisco Unified Customer Voice Portal Release
8.0(1) Solution Reference Network Design (SRND) guide before configuring your Unified CVP
solution.

Unified CVP provides the following additional documentation:

• Cisco Security Agent Installation/Deployment for Cisco Unified Customer Voice Portal
provides installation instructions and information about Cisco Security Agent for the Unified
CVP deployment. We strongly urge you to read this document in its entirety.

• Configuration and Administration Guide for Cisco Unified Customer Voice Portal describes
how to set up, run, and administer the Cisco Unified CVP product, including associated
configuration.

• Element Specifications for Cisco Unified CVP VXML Server and Cisco Unified Call Studio
describes the settings, element data, exit states, and configuration options for Elements.

• Operations Console Online Help for Cisco Unified Customer Voice Portal describes how to
use the Operations Console to configure Unified CVP solution components.

• Port Utilization Guide for Cisco Unified Customer Voice Portal describes the ports used in
a Unified CVP deployment.

Installation and Upgrade Guide for Cisco Unified Customer Voice Portal Release 8.0(1)
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• Programming Guide for Cisco Unified CVP VXML Server and Cisco Unified Call Studio
describes how to build components that run on the Cisco Unified CVP VXML Server.

• Reporting Guide for Cisco Unified Customer Voice Portal describes the Reporting Server,
including how to configure and manage it, and discusses the hosted database.

• Say It Smart Specifications for Cisco Unified CVP VXML Server and Cisco Unified Call
Studio describes in detail the functionality and configuration options for all Say It Smart
plugins included with the software.

• Troubleshooting Guide for Cisco Unified Customer Voice Portal  describes how to isolate
and solve problems in the Unified CVP solution.

• User Guide for Cisco Unified CVP VXML Server and Cisco Unified Call Studio describes
the functionality of Cisco Unified Call Studio including creating projects, using the Cisco
Unified Call Studio environment, and deploying applications to the Cisco Unified CVP
VXML Server.

For additional information about Unified ICME, see the Cisco web site
http://www.cisco.com/en/US/products/sw/custcosw/ps1001/tsd_products_support_series_home.html
(http://www.cisco.com/en/US/products/sw/custcosw/ps1001/
tsd_products_support_series_home.html) listing Unified ICME documentation.

Conventions

This manual uses the following conventions:

DescriptionConvention

Boldface font is used to indicate commands, such as user entries,
keys, buttons, and folder and submenu names. For example:

boldface font

• Choose Edit > Find.

• Click Finish.

Italic font is used to indicate the following:italic font

• To introduce a new term. Example: A skill group is a
collection of agents who share similar skills.

• For emphasis. Example: Do not use the numerical naming
convention.

• A syntax value that the user must replace. Example: IF
(condition, true-value, false-value)

• A book title. Example: See the Cisco CRS Installation Guide.
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DescriptionConvention

Window font, such as Courier, is used for the following:window font

• Text as it appears in code or that the window displays.
Example: <html><title>Cisco Systems,Inc. </
title></html>

Angle brackets are used to indicate the following:< >

• For arguments where the context does not allow italic, such
as ASCII output.

• A character string that the user enters but that does not appear
on the window such as a password.

Obtaining Documentation and Submitting a Service Request

For information on obtaining documentation, submitting a service request, and gathering
additional information, see the monthly What's New in Cisco Product Documentation, which
also lists all new and revised Cisco technical documentation, at:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

Subscribe to the What's New in Cisco Product Documentation as a Really Simple Syndication
(RSS) feed and set content to be delivered directly to your desktop using a reader application.
The RSS feeds are a free service and Cisco currently supports RSS version 2.0.

Documentation Feedback

You can provide comments about this document by sending email to the following address:

mailto:ccbu_docfeedback@cisco.com

We appreciate your comments.
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Planning Your Unified CVP Installation
The specific tasks and procedures that you need to perform depend on whether you are performing
an entirely new installation of Unified CVP or upgrading from a previous release of the product.

This chapter contains the following topics:

• Tasks for New Installations of Unified CVP, page 5
• Tasks for Upgrading from Existing CVP Installations, page 6
• What Is Included in Unified CVP Installation?, page 7
• What is Not Included in Unified CVP Installation?, page 8

Tasks for New Installations of Unified CVP

This guide consists of two parts. Chapters 2 through 6 provide the information needed to install
Unified CVP 8.0(1). Chapters 7 through 11 discuss upgrade compatibility, planning, upgrading,
migration, and troubleshooting (see Tasks for Upgrading from Existing CVP Installations (page
6)).

• Chapter 2 explains the tasks that you must perform before running the Unified CVP install
program. These tasks may include the following, depending on your specific deployment:

– Checking hardware and software requirements

– Disabling Cisco Security Agent

– Installing IBM WebSphere Application Server (not required when deploying to Tomcat)

– Installing IBM HTTP Server Web server

– Install the Simple Network Management Protocol and WMI Windows Installer Provider

– Disabling multiple Ethernet interfaces

Installation and Upgrade Guide for Cisco Unified Customer Voice Portal Release 8.0(1)
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– Closing and unlocking all CVP related files before installing

• Chapter 3 explains how to run the main Unified CVP installation program on Windows 2003
systems.

• Chapter 4 explains how to run the Unified Call Studio installation program on Windows XP
and Vista.

• Chapter 5 explains the tasks that you must perform after running the Unified CVP installation
program. These tasks include the following:

– Verifying installation

– Running Reporting batch file

– Excluding CVP processes from anti-virus software port blocking

– Enabling security

– Applying licenses to Call Servers, VXML Servers, Reporting Servers, and Call Studio

• Chapter 6 explains how to remove Unified CVP software components.

Tasks for Upgrading from Existing CVP Installations

The specific tasks you need to perform to upgrade from a previous release to Unified CVP 8.0
vary, depending on the release of the Unified CVP product that you are upgrading from and the
releases of Cisco Unified Contact Enter Enterprise and Unified Communications Manager that
you have on your system. See Upgrading to Unified CVP 8.0 (page 49) for specific instructions.

Note: Automated upgrades from releases prior to CVP 4.0(1) are not supported.

Chapters 7 through 11 discuss upgrade strategies and migration paths from existing Unified
CVP installations to CVP 8.0(1), and troubleshooting.

• Chapter 7 explains CVP 8.0(1) solution upgrade compatibility.

• Chapter 8 discusses CVP 8.0(1) upgrade strategies and considerations.

• Chapter 9 provides information about upgrading to CVP 8.0(1) components.

• Chapter 10 provides guidelines and procedures for performing migrations for deployment
models.

• Chapter 11 provides information concerning how to resolve problems that you may encounter
when installing, upgrading, or removing Unified CVP software.

Installation and Upgrade Guide for Cisco Unified Customer Voice Portal Release 8.0(1)
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What Is Included in Unified CVP Installation?

The Unified CVP Software DVD consists of software for various Unified CVP components.
Out of the box, CVP 8.0(1) provides everything you need to install, configure, and manage your
CVP solution except the optional WebSphere Allocation Server (obtain from IBM).

Unified CVP Components

Core Software

This is the fundamental software of Unified CVP.

The specific components include:

• Call Server (SIP Service, ICM Service, IVR Service, and H.323 Service, which contains
Voice Browser and VBAdmin)

• IOS Gateway files

• Operations Console (often referred to as OAMP) a web-based interface from which you can
configure and manage individual components through an OAMP Resource Manager (ORM),
which is co-located with each managed Unified CVP component. The ORM is invisible to
the end-user.

• SNMP Monitoring

• Support Tools Node Adapter (STNA)

• Support Tools Protocol Adapter (STPA)

Note: If an existing version of STNA resides on a system, the Unified CVP installation process
upgrades the STNA client.

VXML Server

VXML Server is a J2EE and J2SE compliant web application that provides a complete solution
for rapidly deploying dynamic VXML applications.

It also includes ORM, SNMP Monitoring, STNA, and STPA.

Reporting Server

This server provides a historical repository (which can be used for reporting) to a call center.
It receives reporting data from one or more Call Servers and VXML Servers, and stores that
data in an Informix database.

Installation and Upgrade Guide for Cisco Unified Customer Voice Portal Release 8.0(1)
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This server contains the Informix reporting subsystem, ORM, SNMP Monitoring, STNA, and
STPA.

Remote Operations

This software allows remote administration of Unified CVP solution components, such as
ASR/TTS. It includes ORM, STNA, and STPA.

This package is already included in the Core Software, VXML Server, and Reporting packages.

Video Media Server

Video Media Server is not supported in Release 8.0(1).

System Media Files

The sample set of µ-Law 8-bit .wav media files. Choices are American English and Mexican
Spanish.

Note: These files consist of a library of media files/prompts for individual digits, months
(referenced internally by Unified CVP software for a Play Data script type request), and default
error messages, and so forth. Creation of a full set of media/prompts for each locale referenced
by the CVP customer is the responsibility of the customer's Media Administrator.

By default these files are installed to %CVP_HOME%\MediaFiles. (The default location of
%CVP_HOME% is C:\Cisco\CVP.

Call Studio

Although Call Studio is part of Unified CVP, its installer is not included in the CVP installation
program. You can locate the Unified Call Studio installer on the Unified CVP installation DVD.
Instructions for running the Call Studio installation program are provided in Installing Unified
Call Studio (page 27).

What is Not Included in Unified CVP Installation?

The procedures in this guide pertain only to the Unified CVP components and their connections
to other VoIP system components. This guide does not address initial installation and
configuration of the following VoIP system components:

• Media Server. However, the Unified CVP Installation does supply system media files for
US English and Mexican Spanish.

• ASR/TTS Servers

• CSS C1150x line content services switches

Installation and Upgrade Guide for Cisco Unified Customer Voice Portal Release 8.0(1)
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• Voice Gateways

• Gatekeepers

• ACE

• Cisco MCU

• SIP Proxy Server, CUSP, CUP

• IVP

• Unified CCE/CCH and Unified ICME/ICMH components such as Peripheral Gateways
(PGs), Automatic Call Distributors (ACDs), and Support Tools Server

• Unified CM

• Cisco Unified Operations Manager (formerly IPC-OM (ITEM))

• Cisco Security Agent (CSA)
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Performing Pre-Installation Tasks
This chapter discusses the tasks that you must perform prior to installing the Unified CVP
software.

Note: Important:

You must stop any third party services and applications running on the server prior to running
the Unified CVP Installer. Some third party services and applications can lock files required by
the installer, resulting in an install error.

This chapter contains the following topics:

• Check Hardware and Software Requirements, page 11
• Disabling the Cisco Security Agent, page 12
• Prepare to Install VXML Server (WebSphere Application Server), page 13
• Installing SNMP and WMI Windows Installer Provider, page 14
• Increasing the Size of the Virtual Memory Paging File, page 16
• Disabling Multiple Ethernet Interfaces, page 16
• Close and Unlock all Unified CVP Related Files Before Installing, page 16
• Plan for Licensing, page 17

Check Hardware and Software Requirements

Before you install the Unified CVP software, make note of all hardware and related software
requirements. Be sure to verify that the servers have enough free hard drive space for the storing
of log files. The Hardware and Software System Specification for Cisco Unified Customer
Voice Portal Software Release  (http://www.cisco.com/en/US/products/sw/custcosw/ps1006/
prod_technical_reference_list.html) provides platform hardware specifications and compatible
third party software version requirements across the major components of the Unified CVP
solution.
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Also refer to the Cisco Unified Customer Voice Portal (CVP) Release Solution Reference
Network Design (SRND)  (http://www.cisco.com/en/US/products/sw/custcosw/ps1006/
products_implementation_design_guides_list.html) for important sizing considerations, such
as the required log space sizing.

Disabling the Cisco Security Agent

If Cisco Security Agent is enabled and running, you must disable it prior to running the Unified
CVP installation program.

To disable the Cisco Security Agent, perform the following steps:

Step 1 From the Windows Start Menu, click Start > Settings > Control Panel > Administrative
Tools > Services.

The Services screen displays.

Figure 1: Windows Services Screen

Step 2 Select Cisco Security Agent.

Step 3 Click the Stop the service link in the upper left corner of the screen.

Step 4 If a Cisco Security Agent Challenge dialog box displays, enter the requested text in the dialog
box and click OK.

When the Cisco Security Agent service has been stopped, the Status column on the Services
screen no longer lists Cisco Security Agent as Started.

Step 5 Double click the Cisco Security Agent entry on the Services screen.

The Cisco Security Agent Properties dialog box displays.
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Figure 2: CSA Properties Dialog

Step 6 From the Startup type drop-down listbox, select Disabled, and click OK.

Note: After installing the software, you must reenable the Cisco Security Agent Service. With
the service disabled, the Agent no longer provides intrusion detection for the server.

Prepare to Install VXML Server (WebSphere Application Server)

If you plan to install the CVP VXML Server, then you must choose which application server
that the VXML Server component will use. The VXML Server component can use one of two
application servers:

• Apache Tomcat application server - included with the Unified CVP installation program. No
additional application server installation configuration is required if you use this option.

• WebSphere Application Server - VXML server can optionally run on WebSphere. The Unified
CVP installation program does not include WebSphere. You must obtain it separately.

If you plan to use optional WebSphere Application Server as your application server for the
VXML Server, you must:

1. Install WebSphere Application Server prior to installing Unified CVP. Refer to your
WebSphere Application Server documentation for installation procedures.

2. Install IBM HTTP Server after installing WebSphere Application Server.

Installation and Upgrade Guide for Cisco Unified Customer Voice Portal Release 8.0(1)
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The IBM HTTP Server is required whenever you are using the WebSphere Application
Server on a Windows system. Without it, WebSphere Application Server is not able to
support the load that Unified CVP might generate. It is important that you install WebSphere
Application Server first and then install IBM HTTP Server. In addition, the WebSphere
Application Server and IBM HTTP Server must be installed prior to installing VXML
Server. Refer to your IBM HTTP Server documentation for IBM HTTP Server installation
procedures.

The IBM HTTP Server service starts automatically at Windows startup. If at any point
the IBM HTTP Server is shutdown, the VXML Server no longer operates correctly. Refer
to the IBM HTTP Server documentation for instructions on how to start/stop/administer
the IBM HTTP Server.

3. Modify the module class loader order for CVP.war using the WebSphere Administrative
Console. To do this, in the WebSphere Administrative Console, navigate to Applications
> Enterprise Applications > CVP_war > Manage Modules > Cisco Unified CVP
VXML Server and from the Class loader order drop-down, select Classes loaded with
application class loader first. Click on Apply and then OK.

4. Save the changes to the master configuration.

5. After Unified CVP is installed, complete the Post-installation Tasks for Websphere (page
30).

Installing SNMP and WMI Windows Installer Provider

You must install the Windows Simple Network Management Protocol (SNMP) and WMI
Windows Installer Provider sub-components prior to installing Unified CVP.

Warning: You must have the Windows 2003 Server CD to complete this task.

To install SNMP and WMI Windows Installer Provider sub-components, perform the following
steps.

Step 1 From the Windows Start menu, select Control Panel > Add or Remove Programs.

The Windows Add or Remove Programs screen displays.

Step 2 Select Add/Remove Windows Components.

The Windows Components Wizard Screen displays.
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Figure 3: Windows Component Wizard

Step 3 Select Management and Monitoring Tools.

Step 4 Click Details.

The Management and Monitoring Tools screen displays.

Figure 4: Management and Monitoring Tools Screen

Step 5 Select the Simple Network Management Protocol, WMI SNMP Provider, and WMI
Windows Installer Provider check boxes, and then click OK.
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The Windows Component Wizard performs the necessary installation/configuration.

Step 6 Click Next to complete the setup of SNMP/WMI.

Increasing the Size of the Virtual Memory Paging File

You can improve performance on all CVP machines by changing the way Windows uses
processor time and memory. The recommended size of virtual memory pagefile is equivalent
to 1.5 times the amount of RAM on your system.

Note: You must be logged on as an administrator to perform this task.

To change the size of the virtual memory paging file, perform the following steps.

Step 1 From the Windows Start menu, click Start > Settings > Control Panel.

Step 2 Double-click System.

Step 3 On the Advanced tab, under Performance, click Settings.

Step 4 On the Advanced tab, under Virtual memory, click Change.

Step 5 Under Paging file size for selected drive, click Custom size and type a new paging file size
in megabytes in the Initial size (MB) and Maximum size (MB) box, and then click Set.

Note: The Initial and Maximum size should be set to the same value.

Disabling Multiple Ethernet Interfaces

The machine that you are using for the Unified CVP Call Server must have only one Ethernet
interface enabled. When installing Unified CVP on a machine with two or more Ethernet
interfaces, the additional interface(s) must be disabled, even if they are not configured. Refer
to Windows documentation for information on enabling/disabling an Ethernet interface.

Close and Unlock all Unified CVP Related Files Before Installing

Before you attempt to install Unified CVP or any of its associated Service Releases or
Maintenance Releases, make sure that all other applications are shut down and opened files are
closed. In addition, if a file that the Unified CVP installation program requires is locked, a failed
installation could result.

If you are using McAfee® VirusScan® on a system, you need to launch the VirusScan console,
right-click Access Protection and select properties. Select the File, Share, and Folder
Protection tab and disable rules that lock the files or folders that are required by the Unified
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CVP installation program. If you are using a different anti-virus product, you need to perform
the equivalent file blocking exclusions in that product's file and folder protection rules.

Plan for Licensing

Unified CVP Licensing

Unified CVP has a 30 day evaluation license. The Call Server and VXML server evaluation
licenses now support 30 ports instead of the previously supported 2 ports on all call control
servers; and 10,000 reporting server db writes instead of the previous support for 5000 db writes.
After 30 days Unified CVP must be licensed for continued functionality.

Starting in Release 8.0(1), Unified CVP supports FlexLM licensing for all licensed components
of the CVP system (Call Server, Reporting Server, VXML Server, and Call Studio).

CVP now supports four types of license features:

• "CVP_SOFTWARE" - the basic feature license required for CVP 8.0(1). If this license is
not available, then Unified CVP runs in evaluation mode and any port licenses are ignored.

• "CVPPorts" - the license for the ports on the Call Server.

• "RPT" - the license for the reporting server.

• "SelfServicePorts" - the license for the ports on the VXML Server.

CVP licenses for all CVP devices (CVP Call Server, CVP Reporting Server, CVP VXML
Server, CVP VXML Server (standalone)) are aggregated in the cvp.license file located in
%CVP_HOME%\conf\license. Every time a license is applied via the Operations Console, the
license is appended to the cvp.license file. If there is more than one valid VXML license within
the license file, then the ports are additive. For example, if one CVP license file has 200 VXML
ports and an additional license is applied with 100 more VXML ports, then the VXML server
adds licenses from both, creating 300 licensed ports. Call Servers and Reporting Servers do not
support the additive license feature.

For each CVP VXML server that requires a license, you must use the operations console (System
> License Conversion) after the system has been upgraded to generate an XML string and
enter that string into the Cisco license tool http://www.cisco.com/go/license. The tool generates
an equivalent CVP 8.0(1) port license. Once on this page click on Upgrade License, then CVP
Version Migration. Then follow the instructions on the page

When the CVP Reporting Server starts, it begins counting messages. Each time a message is
written to the database, the CVP Reporting Server checks the local date. When database writes
reach 10,000 (the sum of both inserts and updates) in a single day, an alarm is sent and messages
are no longer written to the database. When the local date changes, database writes resume, as
does the count.
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Note:

• The CVP Video Media Server is not a supported installation option in Release 8.0(1).

• CVP no longer reports on the license usage. Instead, it now reports on the port usage based
on the maximum number of ports available in the cvp.license file. This change affects all
reports, the OAMP statistics page, and diagnostic portal license information requests. Alerts
are still issued at the 90%, 94% and 97% thresholds of licensing usage as with previous
releases.

The Solution Reference Network Design Guide provides detailed information about how CVP
components and ports are licensed.

License Requests for New Systems

If you are installing a new system (not an upgrade), then you should have a PAK (Product
Authorization Key). Enter the PAK at http://www.cisco.com/go/license to generate a License
that can be uploaded to your new system. See Applying Licenses (page 31) for information on
how to upload this license to your CVP system.

Licensing for Upgrades

If you are upgrading an existing system from Release 4.x or 7.x to Release 8.0(1), then you
enter your contract number into the Cisco license tool. http://www.cisco.com/go/license. The
tool verifies an upgrade entitlement and returns a PAK (Product Authorization Key). If there is
no entitlement to an upgrade, then you are given the option to purchase a PAK.

Once you have the PAK, you enter it into the Cisco License tool at http://www.cisco.com/go/
license to receive the license file.

For each CVP VXML server that requires a license, you must use the operations console (System
> License Conversion) after the system has been upgraded to generate an XML string and
enter that string into the Cisco license tool http://www.cisco.com/go/license. The tool generates
an equivalent CVP 8.0(1) port license. Once on this page click on Upgrade License, then CVP
Version Migration. Then follow the instructions on the page

Note: The VXML servers operate in evaluation mode (30 ports) until the license has been
upgraded. The license conversion feature generates the "SelfServicePorts" feature license but
the you must still acquire the "CVP_SOFTWARE" feature license by using your PAK in the
license tool. The "CVP_SOFTWARE" feature can be obtained before the upgrade, but the
SelfServicePorts feature must be retrieved after upgrade.

See Applying Licenses (page 31) for information on how to upload your license to the upgraded
CVP system.
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Installing Unified CVP
This section describes how to install Unified CVP software on Windows systems.

Note:

• All Unified CVP components, with the exception of Call Studio, require Windows 2003. Call
Studio requires Windows XP or Vista.

• Windows Regional & Language Options must be set to English (US).

Warning: The Reporting component cannot be installed on a machine with a hostname
that contains a hyphen; the hostname can be no longer than 12 characters.

This chapter contains the following topics:

• Running the Unified CVP Installation Program, page 19
• Later Installation of Additional Unified CVP Components, page 25

Running the Unified CVP Installation Program

Note: Only an administrator can run the Unified CVP installation program. Otherwise, the
installation program will abort.

To install Unified CVP software, perform the following steps.

Step 1 From the CVP\Installer_Windows folder on the Unified CVP installation DVD, run setup.exe.

A Preparing Setup screen and a splash screen display, followed by a Welcome screen.

Step 2 On the Welcome screen, click Next.

A Copyright screen displays.
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Step 3 Review the contents of the Copyright screen, then click Next.

A License Agreement screen displays.

Step 4 Use the scroll bar to review the entire license agreement, then select I accept the terms of the
license agreement and click Next.

The Choose Destination Location screen displays.

Step 5 On the Choose Destination Location screen, specify the drive and directory where the software
will be installed (referred to as %CVP_HOME%, by default C:\Cisco\CVP):

• Click Next to accept the default location.

Note: If the specified directory already exists and contains data, you will be prompted to
choose another directory or remove it before continuing.

• Click Change to select an alternate location, and then click Next.

Step 6 Use the checkboxes on the Select Packages screen to choose the Unified CVP components
(listed below) to install on the local machine.

Unified CVP Components

• Core Software

• VXML Server

• Reporting

• Remote Operations

• Video Media Server (note: Video Media Server is not a supported install option. Do not
check this box.

• System Media Files:

– English Media

– Spanish Media

Review What Is Included in Unified CVP Installation? (page 7) for additional details about
the components. Highlighting the option also provides additional details about the component.

Step 7 Click Next.

An X.509 Certificate screen displays.

Step 8 Specify the following information on the system X.509 certificate.

• Common Name
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This is the only required field. While it is recommended that you specify hostname in this
field, it is not enforced.

Note: With the exception of the Country Name, which may contain up to two alphabetical
characters, all remaining fields on this screen can contain alphanumeric characters.

• Organization or Company Name

• Organizational Unit or Department

• Locality or City

• State or Province

• Country Name (2 letter code)

• Email address

Note: This field can also contain a dash (-), period (.), underscore (_), or at symbol (@).

Note: For fields other than Country Name, the maximum data length is limited to the length of
the field's visible area.

Step 9 After you have entered the information you want to include in the certificate, click Next.

Step 10 If: You are not installing the Core Software component

Then:  Skip to the next step

If: You are installing the Core Software component

Then: The Core Software Settings screen displays

The Core Software Setting screen displays the following installation options.

Table 1: Core Software Setting options

MeaningOption

Call Server

Enables the Unified CVP Call Server service upon
startup.

Enable Call Server

Note: Though present on the disk, Call Server
services do not actually run unless you have
configured them to do so. The Voice Browser is part
of the H.323 Service; it runs as a Windows service.
If you want to run the Voice Browser, ensure that
the H323 Service options are enabled on the Core
Software Settings screen of the CVP installation
program.
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MeaningOption

H.323 Service

Allows the Voice Browser to start automatically
when the system reboots.

Autostart Unified CVP Voice Browser
at system startup

Ensures that the system does not restart automatically
when a Voice Browser error occurs.

No system reboot on error

Causes the Voice Browser process window to display
on the Windows system toolbar. This process

Display Unified CVP Voice Browser
process window on the system display

window may be helpful when deploying in a test
environment for initial troubleshooting.

Operations Console Server

Enables the Cisco CVP OpsConsoleServer windows
service upon startup; this service is not enabled by
default.

Enable Operations Console Server

Note: If this system will contain the only Operation
Console Server in your network, override the default
and enable the Cisco CVP OpsConsoleServer
windows service. Be sure not to use more than one
Operations Console Server to configure a machine,
or data corruption may result.

Choose your selections and click Next.

If you are not installing the VXML Server, proceed to Step 13. If you are installing the VXML
Server, the Application Server Selection for the VXML Server screen displays.

Step 11 If: You want to install and deploy to Apache Tomcat (default)

Then:  Click Next

If: You installed WebSphere (optional) prior to beginning the Unified CVP installation

Then:  Select Manually install to WebSphere and click Next.

Step 12 If: You did not select Reporting on the Select Packages screen,

Then:  Proceed to Step 15.

If: You selected Reporting on the Select Packages screen,

Then: The Choose Database data and backups drive screen displays.

Step 13 Select the root drive where the reporting database data and backups will reside and click Next.

A Database Size Selection screen displays providing the following options:

• Small
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Requires a minimum of 10 GB of free disk space.

Note: The Small database is intended only for use with the All-in-a-Box laboratory system.
It should not be used in a production environment.

• Medium

Requires a minimum of 250 GB of free disk space.

• Large

Requires a minimum of 375 GB of free disk space.

Step 14 Select the appropriate database size and click Next.

The Support Tools Setup screen displays.

Step 15 On the Support Tools Setup screen, select one of the following options:

• Disable Support Tools

• Specify a Preshared key

The Unified CVP Installer uses the preshared key to set up Support Tools with Internet
Protocol Security (IPSEC). This key must be the same key used for the remote Support Tools
server.

The preshared key can be any non-null string of any combination of up to 256 Unicode characters.
When specifying a key, be mindful of your users. A key that is long and complex may provide
adequate security, but might be difficult for your users to type accurately. Valid characters for
the Preshared Key are:

• Alphanumeric characters

• Space

• Any of the following special characters: -.,#&/~`!@$%^*()+={}[]<>?;:_

Step 16 Click Next.

The Ready to Install the Program screen displays. This screen summarizes the packages you
selected for installation.

Step 17 If: You want to review or change your installation settings

Then:  Click Back to return to the Select Packages screen

If: You are satisfied with the installation settings and you are prepared to begin the
install
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Then:  Click Install to begin the Unified CVP installation process

Step 18 If you do not already have Cisco Security Hardening applied on this machine, a dialog box
displays and prompts you to apply Cisco Security Hardening.

Click Yes to apply security hardening unless one of the following is true:

• The machine on which you are installing Unified CVP is a non-Cisco machine, such as a
Media Server or an ASR/TTS Server.

• Your company has its own security policy.

Note: Cisco does not test or support non-Cisco security policy deployments.

The Setup Status screen displays while the InstallShield Wizard proceeds to install Unified
CVP.

Step 19 If:  Installing the Reporting component, the Reporting Password Screen displays.

Then:  Specify a Reporting Password that meets the criteria detailed on the Reporting
Password screen.

If:  Not installing the Reporting component,

Then:  Proceed to Step 21.

Note: The Reporting password requires that the Minimum Password Age parameter be set to
0 days for both the local and/or domain security policy and is subject to both the Unified CVP
password policy and the password policy enforced by the operating system of the computer on
which the Reporting Server resides. For each aspect of the password, the Reporting password
must meet the requirement of the more restrictive policy. If you are installing CVP Reporting
Server please ensure that your local and/or domain security policy for MINIMUM PASSWORD
AGE are set to 0 days for the installation of the CVP Reporting Server component (In Windows,
Control Panel > Administrative Tools > Local Security Policy > Account Policy > Password
Policy). If the reporting password you enter is rejected, review the list of password requirements
displayed by the installer and consider your operating system's password requirements. You
can reconfigure this password repeatedly until an acceptable password is found.

The reporting accounts (informix, cvp_dbadmin) are created at this time.

Step 20 If:  If you are installing the Core Software component, the Operations Console Password
screen displays.

Then:  Specify a password that meets the criteria detailed on this screen and click Next.
Note: The password you enter on the OPERATIONS CONSOLE screen cannot contain
the word admin. The Operations Console administrator account is created at this time.

If:  Not installing the Core Software component,

Then:  Proceed to Step 23.
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When the installation program completes, a Setup Complete screen displays.

Note:

• If you manually installed to Websphere, a dialog box displays reminding you that you must
redeploy the %CVP_HOME%\VXMLServer\war\CVP.war file to your Websphere Application
server. Also, you must copy %CVP_HOME%\lib\log4j-1.2.12.jar to your Websphere
Application server's \ext folder, by default this is C:\Program
Files\IBM\WebSphere\AppServer\lib\ext .

• If you installed the Reporting component, a dialog box displays reminding you to run a
reporting batch file. This dialog box provides information about the reporting batch file that
must be run manually to complete initial setup of Reporting and Reporting Databases. See
Running the Reporting Batch File (page 29) for detailed instructions.

Additionally, when using Websphere, you must configure it so that logs are saved in the correct
location. See Additional Configuration for WebSphere Application Server for Logging (page
30).

Step 21 Depending on the CVP components you chose to install, you may need to restart your computer
immediately after installation. The setup program informs you if the server requires a restart.
Remove any disks from their drives, and click Finish to complete setup.

Later Installation of Additional Unified CVP Components

If, after the installation, you want to install additional Unified CVP components simply run
%CVP_HOME%\bin\setup.exe. Additional package selections are available from the Modify
screen. The choice of packages available will depend on the combination of Unified CVP
components originally installed.

For example, if you install Call Server first, you can later add a VXML Server or a Reporting
Server. If you install VXML Server or Reporting without installing the Call Server, then you
cannot add anything to your installation.
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Installing Unified Call Studio
Note:

• Unified Call Studio is only supported on Windows XP and Vista.

• You must obtain a new license for Release 8.0(1) Unified Call Studio, licenses for prior
releases are not valid with the latest version. See the section on licensing (page 33).

Warning: Windows Vista sets access permissions on the C:\Program Files directory and
allows only users with administrator privileges to write to this directory. Therefore, it is
strongly recommended that you install Call Studio to a directory other than C:\Program
Files.

Running the Cisco Unified Call Studio Installation Program

To install Call Studio, perform the following steps.

Step 1 From the CallStudio\Installer_Windows folder on the Unified CVP installation DVD, run
setup.exe.

A Preparing Setup screen and a splash screen display, followed by a Welcome screen.

Step 2 On the Welcome screen, click Next.

Note: If you click Cancel here or on the dialog screens that follow prior to the "Ready to Install
the Program" screen, no part of the installation will occur, and an Exit Setup dialog box will
display.

A Copyright screen displays.

Step 3 Review the contents of the Copyright screen, then click Next.

A License Agreement screen displays.
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Step 4 Use the scroll bar to review the entire license agreement, then select I accept the terms of the
license agreement, and click Next.

The Choose Destination Location screen displays.

Step 5 On the Choose Destination Location screen, specify the drive and directory where the software
will be installed:

• Click Next to accept the default location.

• Click Change to select an alternate location, and then click Next.

The Ready to Install the Program screen displays; it lists the packages that you selected for
installation.

Step 6 Verify the desired software is listed, and then click Install.

The Setup Status screen displays while the InstallShield Wizard proceeds to install Cisco Unified
Call Studio.

Step 7 On the InstallShield Wizard Complete screen, click Finish to exit the wizard.

You can use the software for 30 days without a license. After 30 days you need to apply a
license. See Applying a License to Call Studio (page 33) for more information.
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Post Installation Tasks
This chapter discusses tasks that you must perform after installing Unified CVP software.

This chapter contains the following topics:

• Running Reporting Batch File, page 29
• Exclude Unified CVP Processes from Anti-Virus Software Port Blocking, page 30
• Additional Configuration for WebSphere Application Server, page 30
• Enable Security, page 31
• Apply Licenses, page 31

Running Reporting Batch File

If you installed the Reporting component, you must run the
%CVP_HOME%\bin\CVP_Database_Config.bat batch file to complete the initial setup of
Reporting and the Reporting databases. This batch file compresses the most recent backup and
allocates additional disk space to the database. It also performs some minor data model changes
and creates several indexes.

To run the reporting batch file, perform the following steps.

Step 1 If you have not rebooted since running the Unified CVP installation program, reboot your
computer before proceeding to Step 2.

Step 2 Log in to windows as user informix. The password is the one you created for reporting during
CVP installation.

Step 3 From the %CVP_HOME%\bin directory, run CVP_Database_Config.bat. Follow the
instructions on screen.

Database Installation Times

• Small - less than 5 minutes

Installation and Upgrade Guide for Cisco Unified Customer Voice Portal Release 8.0(1)

29

 Chapter 5



• Medium - approximately 40 minutes

• Large - approximately 75 minutes

Step 4 Reboot the Reporting Server after the batch file has completed.

Exclude Unified CVP Processes from Anti-Virus Software Port Blocking

On all systems running Unified CVP server components (that is, Call Server, Reporting Server,
and VXML Server) with anti-virus software configured to do port blocking, you should exclude
Unified CVP processes from the port blocking. For Call Server, Reporting Server and VXML
Server, exclude process tomcat6.exe from port blocking. In addition, for Call Server, process
VoiceBrowser.exe should be excluded.

The following instructions may be used to exclude Unified CVP processes from port blocking
when using McAfee VirusScan on a system running Unified CVP Call Server. If you use a
different anti-virus product, you should do the equivalent exclusions in that product's port
blocking rules.

Instructions for McAfee VirusScan on Unified CVP Call Server:

1. Open the VirusScan Console, double click on Access Protection, and click on the Port
Blocking tab.

2. If the two checkboxes for "Prevent IRC communication" are checked, then do the following:

– Edit both of the Prevent IRC communication properties in VirusScan by selecting
it and then clicking on the Edit... button.

– In the Add or edit a port blocking range dialog, add
VoiceBrowser.exe,tomcat5.exe,tomcas6.exe to the Excluded Process text box and
click OK.

Note: It is critical that there are no spaces in the string
VoiceBrowser.exe,tomcat5.exe,tomcas6.exe, or the Unified CVP server may not
function properly.

Additional Configuration for WebSphere Application Server

Required Configuration for WebSphere for Serviceability and Logging

If you deployed Unified CVP VXML Server to IBM Websphere Application Server (WAS),
then you must configure WAS to place the Unified CVP VXML Server logs in the correct
location. To do this, add the following JVM parameter to your WAS configuration:
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-Dccbu.logging.config.file=log4j_vxml.xml

If you do not set this JVM parameter, then the Unified CVP VXML Server logs appear in the
%CVP+HOME%\logs directory, instead of %CVP_HOME%\logs\VXML. Additionally, if you do
not set this JVM parameter, then serviceability does not operate correctly.

JMX Access on WebSphere

You must enable JMX remote access over port 9696 so the Unified CVP Web Services Manager
can access the Unified CVP VXML Server.

Enable Security

Depending on your Unified CVP deployment, there may be security considerations you need
to address. For information, see the "Configuring and Modifying Unified CVP Security" chapter
in the Configuration and Administration Guide for Cisco Unified Customer Voice Portal and
the Security Best Practices Guide for ICM and IPCC Enterprise & Hosted Editions  (http:/
/www.cisco.com/en/US/products/sw/custcosw/ps1001/prod_technical_reference_list.html).

Apply Licenses

If you installed the following Unified CVP components, you must apply licenses for those
components.

• Call Server

• Call Studio

• Reporting Server

• VXML Server

Note: Aside from diminished capacity (30 ports), unlicensed, the Call Server, Reporting Server,
and VXML Server will work right out of the box.

The following sections explain how to apply licenses for those components.

Applying a License to a Unified CVP Server

When you are creating a new Unified CVP Call Server, VXML Server, or Reporting Server,
you must apply a valid license file before using the server. You can browse for and upload the
license file to the Operations Server, and then transfer the license to the Unified CVP Server
that you want to license. Select either an existing license file in the Operations Server database
or a new license file from your local desktop.
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Before a license is applied, the Call Server and the VXML Server supports 30 concurrent sessions
by default. This may be useful for simple testing or evaluation purposes, note that the evaluation
period expires after 30 days. However, a production server must always have a license applied
to support the desired number of concurrent sessions.

To change licensing information for Reporting, VXML, or Call Server, transfer the new license
file as described below and to and restart the server.

Note: Licenses reside at %CVP_HOME%/conf/license/cvp.license.

Procedure

To transfer a license file:

Step 1 From the Device Management menu, choose the type of server to apply a license to. For example,
to apply a license to a VXML Server, choose Device Management, then the type of server
to which you are transferring a license (VXML Server, or Call Server, or Reporting
Server).

The Find, Add, Delete, Edit window lists any servers that have been added to the network map.

Step 2 Select a server by clicking on the link in its Hostname field or by clicking the radio button
preceding it and then clicking Edit.

Step 3 Select File Transfer in the toolbar and then click Licenses.

The File Transfer page displays, listing the Hostname and IP address for the currently selected
Unified CVP server.

Step 4 If the license file is not listed in the Select From Available License Files text box:

a. Click Select a License File from Your Local PC.

b. Enter the file name in the text box or click Browse to search for the license file on the
local file system.

Step 5 If the license is listed in the Select From Available License Files text box, select the license file
and then click Select.

Step 6 Click Transfer to transfer the selected license file to the selected device.

The license is applied to the selected server.

Note:

• You must restart any server to which you transfer a license to ensure it is able to recognize
and apply the newly transferred license file. You can restart the Call Server, VXML Server,
and Reporting Server by using the Operations Console. Refer to Operations Console Online
Help for Cisco Unified Customer Voice Portal for more details.
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• You can verify that the VXML Server is operational and properly licensed by running the
status administrative script (that is, status.bat or status.sh) in
%CVP_HOME%\VXMLServer\admin, and reviewing its output.

• You can verify that the Call and/or Reporting Server are operational by using the Operations
Console and checking the port usage status. Refer to Operations Console Online Help for
Cisco Unified Customer Voice Portal for more details.

See Also

For more information on Unified CVP licensing, refer to the

Configuration and Administration Guide for Cisco Unified Customer Voice Portal

Notes About VXML Server Licensing

Each VXML Server requires a separate license, even if the software is installed on the same
machine. The VXML server license is tied to the IP address. If you change the IP address for
the server then you must request another license.

Whenever VXML Server is started without an active license (for example, the license is missing,
invalid, or expired) it will log a message to the application server console and startup log to
indicate that the license needs to be activated. However, an unlicensed installation of VXML
Server can still be used with up to 30 simultaneous sessions for evaluation purposes. To utilize
more simultaneous sessions, VXML Server must be activated with a valid license.

Applying a License to Call Studio

Call Studio can be used for 30 days after installation without an active license. After 30 days,
an active license must be applied to continue using Call Studio.

Procedure

To apply a license to Call Studio, perform the following steps.

Step 1 Obtain a PAK (Product Authorization Key) and enter that number into the Cisco license tool
at  http://www.cisco.com/go/license. A License file is returned.

Step 2 Open the license file with a text editor and copy the contents.

Step 3 Start Call Studio.

Step 4 From the menu, select Help > Activation...

The Activation... dialog box displays.

Note: After 30 days of using Call Studio, if an active license has not been applied, the
Activation... dialog box will be displayed when Call Studio is started.
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Step 5 In the License field on the Activation... dialog box, paste the license text.

Step 6 Click Activate.

A status bar displays while the license is checked. After activation a message appears that states
"Activation Successful"

.

Step 7 Click OK.

Call Studio continues is now licensed.
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Uninstalling Unified CVP Software
This chapter describes the procedures for uninstalling Unified CVP software components.

This chapter contains the following topics:

• Close and Unlock all Unified CVP Related Files Before Uninstalling, page 35
• Windows 2003 Procedures, page 35

Close and Unlock all Unified CVP Related Files Before Uninstalling

Before you attempt to uninstall Unified CVP components or any of its associated Service
Releases or Maintenance Releases, make sure that all other applications are shut down and
opened files are closed. In addition, if a file that the Unified CVP uninstall program requires is
locked, a failed uninstall could result.

Windows 2003 Procedures

This section discusses the tasks and procedures associated with uninstalling Unified CVP
software from a Windows 2003 system. It includes the following topics.

• Uninstalling the Informix Reporting database from your system.

• Two methods of uninstalling Unified CVP software from your system:

– From the Unified CVP installation program

– From Windows Control Panel
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Uninstalling Informix Dynamic Server

Note: If you installed Reporting, then you must remove Informix prior to uninstalling Unified
CVP software. If you did not install the Unified CVP Reporting component, then this section
is not applicable.

To remove Informix Dynamic Server, perform the following steps:

Step 1 From the Windows Start Menu, select Start > Settings > Control Panel > Add or Remove
Programs.

Figure 5: Add or Remove Programs Control Panel

Step 2 Select Informix Dynamic Server and click Change/Remove.

The Uninstall Informix Dynamic Server dialog box displays.
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Figure 6: Uninstall Informix Dynamic Server Dialog

Step 3 You must select Remove all database server files and all database information.

Step 4 Click OK.

A dialog box displays the following message:

Could not delete product files and/or directories. Check documentation for more details.

Note: This dialog box is present in this release solely due to an Informix product limitation,
and does not indicate a problem with the removal of Reporting.

Step 5 Click OK to continue with the uninstall process.

Step 6 Click Yes in response to each of the following prompts:

• Delete the Informix user?

• Remove Informix Storage Manager (ISM) Servers?

• Remove SNMP extension agents?

A message displays to indicate the Informix Dynamic Server is uninstalled.

Step 7 Click OK.

Uninstalling Unified CVP Software from Windows Control Panel

To remove Unified CVP Software from Windows Control Panel, perform the following steps.

Step 1 Disable Cisco Security Agent.

Disable Cisco Security Agent (page 12) provides detailed instructions.

Step 2 Close all open applications.
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Step 3 Click Start > Settings > Control Panel, and then double-click Add or Remove Programs.

Step 4 Select Cisco Unified Customer Voice Portal / Cisco Unified Call Studio and then click
Remove.

Step 5 Click Next to begin the uninstall process.

The InstallShield Wizard removes all previously installed Unified CVP components.

When the uninstall process finishes, an Uninstall Complete screen displays. Depending on what
components you uninstalled, the uninstall process may require you to reboot your system to
complete the uninstall.

Uninstalling Unified CVP Software with the Installation Program

To remove Unified CVP software with the Installation Program, perform the following steps.

Note: When you uninstall CVP software, the uninstall program does not remove Support Tools.
You will need to remove Support Tools separately.

Step 1 Disable Cisco Security Agent.

See the section Disable Cisco Security Agent (page 12) for instructions.

Step 2 Rerun the setup.exe file of the software you would like to uninstall.

The CVP InstallShield Wizard Modify screen displays.

Step 3 Select the Remove option, and click Next.

Step 4 Select the Unified CVP software you want to uninstall, that is Cisco Unified Customer Voice
Portal or Cisco Unified Call Studio and click Remove.

When the uninstall process finishes, an Uninstall Complete screen displays. Depending on what
components you uninstalled, the uninstall process may require you to reboot your system to
complete the uninstall.
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Understanding CVP Solution Upgrade Compatibility
CVP 8.0(1) supports upgrades from CVP 4.0(x), CVP 4.1(1), and 7.0(x). Because Unified CVP
is both a product and a solution, when planning an upgrade it is not enough to consider only
upgrading the Unified CVP product components. The Unified CVP product relies upon other
key components of the Unified CVP solution.

The following components of the Unified CVP solution are not part of the Unified CVP product
but may be used for a complete solution:

• Unified Communications Manager

• Cisco Unified Intelligent Contact Manager

• Cisco Gateway

• Cisco Gatekeeper

• Cisco Unified Presence Server

• SIP Proxy Server

• Third-Party Automatic Speech Recognition (ASR) and Text-to-Speech (TTS) Servers

• Cisco Content Switch

• Cisco Unified SIP Proxy (CUSP)

• Cisco Application Control Engine (ACE)

Upgrade refers to the general process of moving an existing installation from an earlier release
of Unified CVP to Unified CVP 8.0(1), with no change to the platform it is running on or the
call control mechanism it uses. For example, converting a CVP 4.0(x) Call Server to a CVP
8.0(1) Call Server is an upgrade.
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Upgrade Unified CVP in stages, upgrading in stages reduces risks associated with upgrading
many products at one time. To support the multistage upgrade approach, newer versions of
Unified ICM and Unified CM support the older CVP releases.

For example, you might plan a three-stage process. You upgrade a few components in each
stage such that the stopping point is a fully supported combination of versions. The desired
result is to upgrade the fewest number of components possible, but to push each of those as far
as possible toward the final version. This method of upgrading reduces the number of variables
at each stage, and at the same time reduces the number of times a given component needs to be
upgraded. After each stage, run regression tests to verify that the solution is fully operational
again. At that time, you may opt to run the solution in production at that stage for a period of
time.

When your upgrade plan is in place and you are ready to upgrade, be sure to study the Hardware
and System Software Specification for Cisco Unified Customer Voice Portal (Unified CVP)
Release 8.0(1) to devise a strategy that reduces migration risks for your deployment.

Note: Support of the IBM Websphere Voice Server speech recognition product (version 5.1.2
and 5.1.3) was discontinued in May 2007, and support for this third-party product is not included
as of Release 4.1 of Unified CVP.

Upgrading from Cisco Unified CVP Release 4.0(x), 4.1, or 7.0(x) to Unified CVP 8.0(1)

The basic steps for upgrading Unified CVP Release 4.0(x) 4.1(x) and 7.0(x) to Unified CVP
Release 8.0(1) are outlined below; they take a solution-level compatibility into account. These
steps are recommendations only, you may have specific reasons for following a different
procedure. Be sure to see the Hardware and System Software Specification for Cisco Unified
Customer Voice Portal (Unified CVP) Release 8.0(1) to ensure the solution components are at
versions supported by CVP 8.0(1).

Note:

• CVP 8.0(1) contains new gateway files to be run on the IOS gateway. All of these files must
be deployed on IOS gateways as part of a CVP upgrade. Some of these gateway files may
not be compatible with systems running CVP releases prior to 8.0(1), and must only be used
with systems running CVP 8.0(1) or greater. If other CVP systems are to remain running
prior versions of CVP, these systems must not be using gateways that have had the script
files upgraded to the CVP 8.0(1) versions.

• Important: You must stop any third party services and applications running on the server
prior to running the Unified CVP Installer. Some third party services and applications can
lock files required by the installer, resulting in an install error.

Step 1 Refer to theUnified Contact Center Enterprise (Unified CCE) Software Compatibility
Guide, Release 8.0(1)  (http://www.cisco.com/en/US/products/sw/custcosw/ps1844/
products_device_support_tables_list.html) for the supported software release information for
your products and the Hardware and System Software Specification for Cisco Unified
Customer Voice Portal (Unified CVP) Release 8.0(1)  (Hardware and System Software
Specification for Cisco Unified Customer Voice Portal (Unified CVP) Release 8.0(1)) for the
supported hardware for Release 8.0(1).
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Step 2 Upgrade all Unified CVP sub-components to Unified CVP release 8.0(1). Upgrade in the
following order:

a. Operations Console

b. Reporting Server

c. Call Server

d. VXML Server and Unified Call Studio

Step 3 Upgrade IOS to a version supported in the release 8.0(1) and install the latest Script and Media
Files from the Operations Console.

Step 4 Upgrade to the appropriate release of Unified ICM the JTAPI Client on the Agent PG.

Step 5 Upgrade to the appropriate release of Cisco Unified Communications Manager.

Step 6 Upgrade the JTAPI client on the Agent PG to the client from your upgraded Unified
Communications Manager.

Step 7 Upgrade Gatekeeper, Cisco Unified Presence Server, and CCS.
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Planning Your CVP Upgrade
This section provides an overview of upgrade considerations and strategies that can be used to
perform a CVP upgrade.

This chapter contains the following topics:

• CVP Upgrade Strategies, page 43
• Upgrade Considerations, page 46

CVP Upgrade Strategies

Typically, there is a limited maintenance window in which to perform an upgrade. When there
are a large number of CVP servers, it may not be possible for you to upgrade all of the servers
in one maintenance window. CVP 8.0(1) introduces new upgrade strategies that will help large
CVP deployments segment the upgrade process. Using the concepts of CVP units and multiphased
upgrades you can divide the server upgrades into multiple steps that can be completed over
several maintenance windows.

CVP Units

Some Unified CVP deployments are logically divided so that call paths only traverse sub-sets
of CVP servers. These logical groupings of servers are referred to as a CVP unit. A CVP unit
is comprised of all of the VXML Servers, Call Servers, and Reporting Servers that can be
involved in processing a call. This includes failover machines as well as other CVP units that
a VXML gateway could transfer the call to, as well as any VXML Servers that house VXML
applications called by Subroutine elements.

CVP Deployments that have multiple CVP units can upgrade one unit at a time. This strategy
may be very useful if a call center is migrating from H.323 to SIP and needs to continue call
processing and minimize the risks. The CVP unit must remain offline until all components in
the unit are upgraded.
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An example of a Unified CVP deployment (VXML Servers, Call Servers, Reporting Servers,
and the call paths) is illustrated below.

Figure 7: CVP Servers and Call Paths

The figure shown above depicts two logical CVP units. They are logical units because there is
no path for the call to move from one unit to the other.

• CVP unit 1 - VS1, VS2, CS1, CS2, RS1

• CVP unit 2 - VS3, VS4, CS3, CS4, RS2

The following scenario is an example of how you might upgrade a CVP unit.

Scenario 1: Upgrade a CVP unit of related servers in a maintenance window

• Maintenance Window 1 - RS1, CS1, CS2, VS1, VS2

• Maintenance Window 2 - RS2, CS3, CS4, VS3, VS4

You can upgrade each logical unit independently. Upgrading a CVP unit can be divided further
using the multiphased upgrade strategy, which is described in the following section.

Multiphased Upgrades

A multiphased upgrade refers to the ability to upgrade a subset of Unified CVP servers and
resume call processing. A multiphased upgrade process provides you with additional ways to
divide your upgrades over time. If a CVP deployment has multiple CVP units, each unit can be
upgraded using a multiphased approach.
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Multiphased upgrades must upgrade all components in the following order:

1. Support Tools Server

2. Operations Console (OAMP)

3. Reporting Server

4. Call Servers

5. VXML Servers

Not all servers in a category need to be upgraded in a single maintenance window. However,
you must upgrade all CVP components of one type before moving to the next set of components
in the Unified CVP deployment or the CVP unit.

Figure 8: CVP Servers and Call Paths

The following scenarios are examples of how you might implement the multiphased upgrade.

Scenario 2: Upgrade all servers of a certain type in a maintenance window

• Maintenance Window 1 - RS1, RS2

• Maintenance Window 2 - CS1, CS2, CS3, CS4

• Maintenance Window 3 - VS1, VS2, VS3, VS4

Scenario 3: Upgrade a subset of a server type in a maintenance window

• Maintenance Window 1 - RS1, RS2, CS1
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• Maintenance Window 2 - CS2, CS3, CS4, VS1

• Maintenance Window 3 - VS2, VS3, VS4

Scenario 4: Upgrade a subset of a server types from a CVP unit in a maintenance window

• Maintenance Window 1 - RS1, CS1

• Maintenance Window 2 - CS2, VS1, VS2,

• Maintenance Window 3 - RS2, CS3

• Maintenance Window 4 - CS4, VS3, VS4

Upgrade Considerations

Review the following upgrade considerations when you are planning a CVP unit and/or
multiphased upgrade.

CVP Unit and Multiphased Upgrades

When you divide a product upgrade into multiple steps, it is important that you consider the
following:

General Considerations

• Components co-resident on servers

– Multiphased upgrades are not supported in deployments with co-resident components.

– CVP unit upgrades support co-resident components if all of the co-resident components
are part of the same unit. As with non-coresident components, the CVP unit must remain
offline until all components that comprise the unit are upgraded. For example, if you have
a co-resident VXML Server and Call Server in the same CVP unit, the unit can be upgraded;
when all of the components are upgraded the unit can begin to process calls.

Caution: If a deployment did not follow the upgrade order and that deployment were to
handle calls, some call data may be lost. For example, if a 4.0(x) Reporting Server were
to receive a message from an 8.0(1) Call Server, none of the new fields and/or messages
introduced in CVP 8.0(1) would be persisted about that call.

Operations Console (OAMP)

• Unified CVP 8.0(1) supports one Operations Console Server per deployment.

• The Operations Console must always be upgraded first. If it is not, you will be unable to
configure properties introduced in the Unified CVP 8.0(1) release.
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• The Operations Console displays only the latest released version of the user interface. Interface
screen formats for earlier versions of a device type are not supported. For example, if a Call
Server is at version 4.0(x), the 8.0(1) version of the Call Server configuration screen displays
with any new configuration options and default values, if applicable.

• If the Operation Console performs an online view for a device type of an older release version,
defaults are applied in an effort to populate the new properties that are unknown to the older
device type.

• To continue to support device types at older versions, you cannot remove or modify the
attributes of an existing property using the Operations Console.

• If a previous version component receives a configuration property that applies only to the
new version, it will log a trace message.

• Unified CVP device type version information is available for all Unified CVP 8.0(1)
components. Version information for CVP device types that have not been upgraded is not
available.
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Upgrading to Unified CVP 8.0(1)
Unified CVP supports upgrade of its product components from CVP 4.0(x), CVP4.1(1), or CVP
7.0(x) to Unified CVP 8.0(1). When planning an upgrade, however, it is not enough to consider
only upgrading the CVP product components. There are dependencies all across the solution
for operating systems, Cisco software such as Unified Contact Center Enterprise, Unified CM,
and IOS, and third-party software. In addition, there are changes in Unified CVP Release 4.1(1)
that may necessitate migrating existing Unified CVP installations to different deployment
models.

You must also apply new licenses for all Unified CVP components. See the section on licensing
(page 31) for details on obtaining and applying licenses.. If you do not apply licenses to upgraded
components then the software runs in evaluation mode.

This chapter provides the following information related to upgrading to Unified CVP Release
8.0(1).

• A summary of component and hardware changes in Unified CVP Release 8.0(1)

• A summary of required releases of related software (operating system, Cisco software, and
third-party software) in Unified CVP Release 8.0(1)

• Instructions for upgrading from a previous release of CVP to Unified CVP Release 8.0(1)

• Guidelines for performing the associated deployment migrations

This chapter contains the following topics:

• Hardware Changes, page 50
• CVP Solution Component Upgrades, page 51
• Upgrading Unified CVP Software, page 51
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Hardware Changes

An upgrade to CVP Release 8.0(1) may require the purchase of additional hardware. When you
are assessing the work that needs to be done in upgrading your existing CVP deployment to
Unified CVP Release 8.0(1), be sure to account for the following changes:

• All Unified CVP Call Control Servers and Windows-based VXML Servers must run Windows
2003.

• Reporting Servers are optional components. If your deployment requires reporting
functionality, you will need to deploy additional machines for that purpose.

• Standalone Distributed Diagnostics and Service Network (SDDSN) is no longer required. If
you have SDDSN server, you might consider decommissioning these servers or using them
for other purposes.

• CVP Operations Server is a required component. Refer to the Cisco Unified Customer Voice
Portal (CVP) Release Solution Reference Network Design (SRND)  (http://www.cisco.com/
en/US/products/sw/custcosw/ps1006/products_implementation_design_guides_list.html) for
detailed descriptions of the deployment options. This includes Standalone deployments. If
an SDDSN Server meets the appropriate specifications, it can be reused as a CVP Operations
Server.

• Gatekeepers are not required in SIP implementations. If you are moving to or using SIP,
gatekeepers can be decommissioned or in some cases converted to use as ingress or VXML
gateways (or both).

• SIP Proxy Servers and DNS Servers for SIP message routing are optional components for
SIP implementations. If you intend to use such components, you will need to add them to
the network. SIP Proxy Servers and DNS Servers cannot co-reside with other CVP product
components.

• Dedicated Type 2 and Type 8 CVP Call Control Servers are no longer necessary.

• If you are using older gateway or gatekeeper hardware, the version of IOS required in this
release may no longer support that hardware, making it necessary for you to purchase new
hardware. For more details, see your IOS documentation and the Unified CVP Bill of Materials
at the following location. Hardware and Software System Specification for Cisco Unified
Customer Voice Portal Software Release  (http://www.cisco.com/en/US/products/sw/
custcosw/ps1006/prod_technical_reference_list.html).

• As of CVP 4.0, Media Termination is no longer supported in the H.323 service. You must
migrate all calls that formerly used H.323 media termination to the Comprehensive deployment
model, using either Session Initiation Protocol (SIP) (preferred) or H.323 for call control.
Perform this migration after the upgrade to Unified CVP Release 4.1. See the section
Migrations for Deployment Models (page 61) later in this chapter for details.
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CVP Solution Component Upgrades

Most solution components have their own individual upgrade procedures which are beyond the
scope of this document. Some of these components are specifically mentioned here however,
because their configurations are so closely tied to CVP.

IOS Gateway

Cisco gateways need to be upgraded to the IOS release specified in the CVP Solution Upgrade
Compatibility Matrix. The new version of IOS has a number of syntax changes from earlier
versions, particularly in the area of Call Applications. You can find the CVP Solution Upgrade
Compatibility Matrix in the Hardware and Software System Specification for Cisco Unified
Customer Voice Portal Software Release  (http://www.cisco.com/en/US/products/sw/custcosw/
ps1006/prod_technical_reference_list.html).

When the new version of IOS is started, it automatically converts the running configuration to
the new syntax.

Note: It is very important that you back up the old configuration before proceeding; there is no
way to undo the upgraded configuration.

Unified CVP Release 8.0(1) introduces new error.wav files. You need to locate the files on the
VXML Server and copy them to flash memory on the gateway. The error.wav media files reside
in %CVP_HOME%\OpsConsoleServer\GWDownloads (for example,
C:\Cisco\CVP\OpsConsoleServer\GWDownloads). Refer to the Configuration and Administration
Guide for Cisco Unified Customer Voice Portal to learn more about all of these changes.

Application Control Engine (ACE)

If your deployment includes Cisco Content Services Switch devices, you need to upgrade the
devices to the Application Control Engine (ACE). In this application of ACE, the engine is used
primarily to direct initial session requests for a particular type of service. You can find the ACE
version information in theHardware and Software System Specification for Cisco Unified
Customer Voice Portal Software Release  (http://www.cisco.com/en/US/products/sw/custcosw/
ps1006/prod_technical_reference_list.html). Follow the Application Control Engine (ACE)
configuration instructions for CVP 8.0(1).

Upgrading Unified CVP Software

This section lists the procedure for upgrading from a previous release of Unified CVP 4.0(x),
4.1(1), or 7.0(x) to Unified CVP 8.0(1). It discusses the following steps:

• Backing up the Unified CVP Disk

• Working with Cisco Security Agent (CSA)
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• Upgrading Cisco Unified CVP VXML Server and Unified Call Studio

• Migrating previously-deployed Unified CVP voice applications

• Upgrading other Unified CVP Software to Release 8.0(1)

• Upgrading non-CVP software

Backing Up the Unified CVP Disk

This upgrade does not have roll back functionality. While not required, it is a best practice to
back up the entire disk prior to this upgrade. The backup will be useful if, at any point, a
downgrade is necessary. For details about how to back up the configuration of the Operations
Console, refer to "Exporting an Operations Console Configuration" in the Operations Console
Online Help for Cisco Unified Customer Voice Portal. For information about backing up the
Reporting Server database, refer to "Database Backup" in the Reporting Guide for Cisco Unified
Customer Voice Portal.

Working with Cisco Security Agent (CSA)

Previous releases of Cisco Security Agent (CSA) for CVP Software are not compatible with
Unified CVP Release 8.0(1) and must be upgraded. If Cisco Security Agent is enabled and
running, you must first stop CSA and then disable it before upgrading the Unified CVP Software.
See Disable Cisco Security Agent (CSA) (page 12) for detailed instructions. Refer to the Cisco
Security Agent Installation/Deployment Guide for Cisco Unified Customer Voice Portal, Release
8.0(1) for more information about how to upgrade, disable, or reenable the CSA service.

Note: After upgrading the software, you must reenable the Cisco Security Agent Service. With
the service disabled, the Agent no longer provides intrusion detection for the server.

The CVP installation program detects the presence of the Cisco Security Agent on the target
installation machine but does not check that the CSA version requirement has been met. The
Hardware and Software System Specification for Cisco Unified Customer Voice Portal
Software Release  (http://www.cisco.com/en/US/products/sw/custcosw/ps1006/
prod_technical_reference_list.html) provides platform hardware specifications and compatible
third party software version requirements across the major components of the Unified CVP
solution.

Upgrading Cisco Unified CVP VXML Server and Unified Call Studio

In Unified CVP Release 8.0(1), Unified Call Studio must be run on development machines,
separate from VXML Server. Unified Call Studio is supported on developer workstation software
from Microsoft, specifically Windows XP and Windows Vista, but not the Windows 2003 server
software.

When you upgrade from Call Studio 4.0, the installer uninstalls currently installed CVP Studio
but retains all of its custom files. All CVP Studio voice application projects and any custom
libraries are retained. The CVP Studio backup directory is renamed to CVP4.0_VXMLStudio.
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You can later retrieve the libraries and applications to migrate them to a Call Studio installation.
After CVP Studio 4.0 is uninstalled via the VXML Server upgrade process, Call Studio must
be installed on a Windows XP or Vista machine using its separate installer. Refer to Installing
Unified Call Studio (page 27) for complete installation instructions.

You can upgrade Call Studio 4.0(x), 4.1(1), 6.0(x) and 7.0(x) to Call Studio 8.0(1). However,
there is no upgrade available for Call Services Studio. You can Migrate from Call Services
Studio (page 55).

Note: The CVP Studio directory is backed up only when you upgrade from CVP 4.0 to CVP
4.1 or CVP 7.0. There is no backup from CVP 4.1 to CVP 7.0 because the files are upgraded
in-place, which means you retain your files as they were in the previous version.

Audio files deployed to CATALINA_HOME\webapps\CVP\audio will be deleted (where
CATALINA_HOME is the Tomcat installation directory). It is recommended that you back up
the audio files prior to the upgrade.

The following steps outline the recommended upgrade path for VXML Server and Call Studio.
These steps apply both to the development and production machines that comprise your Unified
CVP deployment. For machines that will not include the VXML Server and Call Studio
components, skip this section and the next and proceed to Upgrading Non-CVP Software (page
59).

Upgrading Cisco Unified CVP VXML Server

To upgrade the Cisco Unified CVP VXML Server, perform the following steps.

Note: When you upgrade Cisco Unified CVP VXML Server to release 8.0(1) you must also
upgrade Unified Call Studio (or migrate from Call Services Studio) to Release 8.0(1). The
VXML Server and Call Studio version must be the same for Call Studio applications to work
with the VXML Server.

You must also apply new licenses for all Unified CVP components. See the section on licensing
(page 31) for details on obtaining and applying licenses.. If you do not apply licenses to upgraded
components then the software runs in evaluation mode.

Step 1 On test and production servers, back up any third party libraries (.class or .jar files) found in
the following locations (where APP_NAME is the name of each deployed voice application):

%CVP_HOME% is in C:\Cisco\CVP by default:

• %CVP_HOME%\VXMLServer\common\classes

• %CVP_HOME%\VXMLServer\common\lib

• %CVP_HOME%\VXMLServer\applications\APP_NAME\java\application\classes

• %CVP_HOME%\VXMLServer\applications\APP_NAME\java\application\lib

• %CVP_HOME%\VXMLServer\applications\APP_NAME\java\util
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Step 2 Run the Unified CVP 8.0(1) installer.

Note: On runtime systems that have CVP Studio 4.x installed, the upgrade uninstalls CVP
Studio but retains all of its custom files. For example, all CVP Studio voice application projects
and custom libraries are retained. The CVP Studio folder is renamed to CVP4.0_VXMLStudio.
You can later retrieve the libraries and applications, to migrate them to a Call Studio installation.

Step 3 Restore any backed up third party libraries that were discovered during Step 1 to their former
locations. Note that some voice applications may include copies of these libraries as part of
their Call Studio projects, in which case they may already be present. Minimally, any libraries
backed up from %CVP_HOME%\VXMLServer\common\lib and
%CVP_HOME%\VXMLServer\common\classes should be restored as these will not have been
deployed as part of any Studio projects.

Note: In addition to the following the above steps, refer to the Configuring a VXML Server
section of the Configuration and Administration Guide for Cisco Unified Customer Voice Portal
for details about how to configure VXML Server using the Operations Console.

Upgrading Cisco Unified Call Studio

You can upgrade Call Studio 4.0(x), 4.1(1), and 7.0(x) to Call Studio 8.0(1).

Note:

• You must obtain a new license for Release 8.0(1) Unified Call Studio, licenses for prior
releases are not valid with the latest version. See the section on licensing (page 33).

• There is no upgrade available for Call Services Studio. If you are moving from Call Services
Studio then you must export your applications, uninstall Call Services edition, then install
Unified Call Studio 8.0(1) and import your applications.

To upgrade the Cisco Unified Call Studio, perform the following steps.

Step 1 On development machines, use Call Studio to export all projects to offline media if they are not
already stored in version control systems. Projects can be exported by right-clicking on any
project in the Navigator view, choosing Export…, and completing the Export wizard. Note that
multiple projects can be exported simultaneously, by checking them off in the list presented by
the Export wizard.

Step 2 Run the Call Studio installer.

Step 3 Import previously exported projects into Call Studio. Be sure to select the Existing Cisco
Unified CVP Project into Workspace option.

The import process automatically upgrades the projects to the CVP 8.0(1) format, if necessary.

See the Applying a License to Call Studio (page 33) section of this guide for instructions about
how to apply a license to Call Studio.
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Note: If applications are checked out from a source repository (rather than imported from the
file system), those applications should still be re-imported as a Call Studio project to initiate
the conversion process. In addition, for the first check-in after importing, all files in each project
are considered modified and need to be updated in the repository.

Step 4 Recompile any custom components compiled under a Java version lower than 1.4, using Java
5.

Custom components compiled under Java 1.4 are expected to run on Java 5 without the need
for recompilation. However, it is the user's responsibility to review the list of Java 5 changes
that may affect backwards compatibility and make any required updates. You can locate the
compatibility page at: http://java.sun.com/j2se/1.5.0/compatibility.html.

Migrating From Call Services Studio

To migrate from Call Services Studio:

Step 1 Export Call Services Studio applications.

a. In Call Services Studio select File > Export.

b. In the export destination field, expand General select File System and click Next.

c. Check the boxes next to all of the application you want to export. Verify all of the file
types in the right panel are checked.

d. Click Browse... to select a directory to which to export the applications. Select the directory,
then click Finish.

Step 2 Create a backup of your Call Services Studio installation and all application files.

Step 3 Uninstall Call Services Studio.

Step 4 Install Unified Call Studio 8.0(1).

Step 5 Import Call Services Studio application into Call Studio 8.0(1).

a. In Unified Call Studio 8.0(1), select  File > Import.

b. In the import source field, expand Call Studio and select Existing Call Studio into
Workspace. Click Next.

c. Click Browse... to select a directory in which you exported your applications. You should
select the directory inside the directory you created to export all the applications. Select
an application directory, then click Finish. Repeat for each application.

d. Validate your applications.
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Cisco Unified CVP Reporting Server Upgrade

Upgrading the Reporting Server

The in-place upgrade of an existing CVP Reporting Server can be a time consuming endeavor.
The following is an explanation of what occurs during this upgrade and what can be done to
improve that performance.

1. The most recent backup is compressed to generate more disk space. The previous backup
is removed. Large databases take about 80 minutes, Medium 40 minutes, Small 2 minutes.
If the backup file does not exist, the compression process runs very quickly.

2. Freed up space is then allocated to the database. Large databases take about 33 minutes,
Medium 17 minutes. If the space could be allocated before the upgrade runs then this step
happens very quickly.

3. Data Model changes are then done. Large databases take approximately 65 minutes,
Medium 35 minutes. The time taken for this step will depend on how much data is retained.
The time needed for this step can be reduced by temporarily lowering the number of days
retained for the CVP tables and executing a purge.

4. Next Index creation is done. A number of indices are added to existing tables. The time
taken for this step will depend on how much data is retained. The needed for this step can
be reduced by temporarily lowering the number of days retained for the CVP tables and
executing a purge.

5. Finally, final backup of converted database started. Large databases take approximately
20 minutes, Medium 10 minutes. The time taken for this step depends on how much data
is retained. The time needed for this step can be reduced by temporarily lowering the
number of days retained for the CVP tables and executing a purge.

The total upgrade time for a full large reporting server database is expected to take approximately
4 hours.

The total upgrade time for a full medium reporting server database is expected to take
approximately 2 hours.

When the %CVP_HOME%\bin\CVP_Database_Config.bat file starts, it will look at the
current installation and develop an estimate of the time required to perform the upgrade. If this
time seems excessive, abort the script, reduce the retention period for CVP tables, execute a
purge and then return to run the %CVP_HOME%\bin\CVP_Database_Config.bat script.

The amount of time required to execute this script varies according to the size of the Reporting
Server installation and the amount of data stored in it. This is illustrated in the following table:

Note: The following information is currently hypothetical and is meant to be illustrative, not
definitive.
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Estimated Upgrade TimeAmount of Historical Data Held In

Database

Reporting Server Installation Size

20 minutes10 days worth of dataSmall

30 minutes30 days worth of dataSmall

2 hours10 days worth of dataMedium

4 hours30 days worth of dataMedium

3 hours10 days worth of dataLarge

6 hours45 days worth of dataLarge

Before starting the upgrade:

• Verify that a database backup exists.

• Turn off scheduled purge.

Perform the following to upgrade the Reporting Server:

Step 1 Run the Unified CVP 8.0(1) installer.

The Welcome to the Upgrade Install of CVP screen appears

Step 2 Click Next.

The Copyright screen appears.

Step 3 Click Next.

The License screen appears.

Step 4 Select Accept, then click Next.

The X.509 Certificate screen appears.

Step 5 Click Next.

A few moments will pass, then the Support Tools screen appears.

Step 6 Click Next.

The Password prompt appears.

Step 7 Enter the password, then click Install.

A period of time passes as the services are stopped, then a preparing to install message appears.
After a few moments, the Installing dialog appears.

Step 8 When the "Done with the automated portion of the upgrade installation." message appears, login
as cvp_dbadmin.
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Step 9 Run %CVP_HOME%\bin\CVP_Database_Config.bat.

Step 10 After the batch file has completed running, Open Windows Services, select "Informix Server
Discover Process for SNMP". On the Logon tab, select This Account and enter the credentials
for the informix user. Click OK.

Note: If you fail to complete this step, then upon reboot the Service Control Manager notifies
of failed services.

The two failed services are:

• The OnSrvapd service cause: (Unable to log on as \informix)

• The Informix Server Discovery Process for SNMP (cause: logon failure)

Step 11 Reboot the reporting server.

Migrating Previously-Deployed Unified CVP 4.1 Voice Applications

If you have previously-deployed Unified CVP 4.1 voice applications that you would like to run
as-is on Unified CVP 8.0(1) (that is, without redeploying them from Call Studio), you can do
so. VXML Server 8.0(1) is capable of directly running deployed Unified CVP 4.1 voice
applications. All functionality is maintained, and no manual steps are required. However, if you
would like to take advantage of this release's new features (such as, web services integration,
Subdialog Invoke, Local Hotlinks, etc.), you may prefer to import the projects into Call Studio.

Upgrading Other Unified CVP Software to Release 8.0(1)

This section pertains to Unified CVP software other than VXML Server and Call Studio. The
steps used to upgrade these components differs from the steps for a new installation.

Upgrading to Unified CVP Release 8.0(1) requires temporarily stopping all Unified CVP services
and processes on your Unified CVP components. Therefore, to limit impact to a live Unified
CVP system, upgrade during a maintenance period when your Unified CVP system is out of
production.

To upgrade a component to Unified CVP Release 8.0(1), launch the Unified CVP 8.0(1) installer
package. The system detects the previous installation and recognize that an upgrade is desired.
Detection and upgrade of the previous components is managed by the installer. Next, perform
the following steps.

1. From the CVP\Installer_Windows folder on the Unified CVP installation DVD, run
setup.exe.

A Preparing Setup screen and a splash screen display, followed by a Welcome screen.

2. On the Welcome screen, click Next.

A Copyright screen displays.
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3. Review the contents of the Copyright screen, then click Next.

A License Agreement screen displays.

4. Use the scroll bar to review the entire license agreement, then select I accept the terms
of the license agreement and click Next.

After you accept the terms of the license agreement, a warning displays to indicate the upgrade
is about to start. Because the upgrade does not change the deployment model, there is no option
to select packages and components. The installer proceeds to copy and install the files. When
the installer completes, you are prompted to reboot.

On systems that have CVP Studio 4.1 installed, the upgrade uninstalls CVP Studio but retains
all of its custom files. For example, all CVP Studio voice application projects and custom
libraries are retained. The CVP Studio folder is renamed to CVP4.0_VXMLStudio. You can
later retrieve the libraries and applications, to migrate them to a Call Studio installation.

Unified CVP 8.0(1) utilizes new scripts for the VXML Gateway. The Unified CVP
Comprehensive call flow model requires that the VXML, .wav, and .tcl scripts on the VXML
Gateway match the CVP Call Server version. Since the CVP 8.0(1) installer does not
automatically copy the new files to the gateway, you need to use the Unified CVP Operations
Console to transfer the appropriate scripts to the VXML Gateway. Refer to the Operations
Console online help for instructions about how to transfer scripts to a gateway. Refer to the
Configuration and Administration Guide for Cisco Unified Customer Voice Portal  for detailed
information about comprehensive call flow model.

Upgrading Non-CVP Software

If upgrades to the following Cisco and third-party software are necessary, perform these upgrades
at this time.

• ASR/TTS Server software

• Gateway IOS

• Gatekeeper IOS

• CSS

See the Hardware and System Software Specification for Cisco Unified Customer Voice Portal
(Unified CVP) Release to determine what upgrade(s) are necessary.

Note:

• Tomcat Application Server Release 5.5.27 is installed if you choose Tomcat as your application
server during the install process; a separate upgrade for this component is not necessary.

• Upgrade the required non-CVP components during the maintenance period when the Unified
CVP components are being upgraded. Unified CVP components should be upgraded in a
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specific order. Multiphased upgrades (page 43) provides additional information about the
component upgrade sequence.
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Performing CVP Solution Migration

Migrations for CVP Deployment Models

With the additions and changes in functionality in Unified CVP Release 8.0(1), there are a
number of possible deployment migrations you may want to consider:

• Migrating Comprehensive or Call Director Deployment Models from H.323 to SIP

• Migrating from Tomcat to WebSphere Application Server

• Adding reporting or ICM Lookup capability to VXML Server

This section provides guidelines and procedures for performing these migrations.

Migrating Comprehensive or Call Director Deployment Models from H.323 to SIP

If your current CVP deployment model is Comprehensive or Call Director, and you want to
migrate from H.323 to SIP, follow the instructions in this section to perform this migration.

This migration involves the following tasks:

• Optionally, deploying new SIP Proxy Servers and/or DNS Servers.

• Adding SIP service capabilities to Unified CVP Call Servers.

• Configuring SIP dialed number mappings.

• Configuring ingress gateways, VXML gateways, and Cisco Unified Communications
Managers.

• Testing the updated configuration and removing H.323 support if testing is successful.
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When converting from H.323 to SIP and using the Comprehensive or Call Director call flow
models, it is important to note that SIP does not support GKTMP and inbound dynamic routing
is done via CUSP proxy support.

To perform this migration, perform the following steps:

Step 1 Install and configure the SIP Proxy Servers and/or DNS Servers.

Step 2 Add SIP services to the CVP Call Control Servers capabilities, if necessary. It is not necessary
to remove H.323 services at this point. If SIP Proxy Servers are being used, configure the SIP
services to point to those devices.

Step 3 Configure SIP dialed number mappings. If you are using SIP Proxy Servers, perform the
configuration in those servers. If not, perform this configuration in the SIP services configuration
screens of the CVP Operations Console. For this process, use your Gatekeeper zone prefix list
as a guide. The same dialed numbers that are configured in the gatekeeper now need to be
configured for SIP.

You must map the following three classes of dialed numbers :

• VRU transfer labels: This includes any numbers that target VXML gateways. If correlationId
routing is used, then the dialed numbers you specify here must be suffixed with a wildcard
to allow for the variable correlationId. If TranslationRouteToVRU routing is used, then
configure all translation route DNISs here.

• Incoming DNISs: In the gatekeeper, these are the numbers that target the CVP Call Control
Servers (or, more precisely, the CVP Voice Browsers). For SIP purposes, these should target
the CVP Call Servers.

• ACD or agent DNISs: This includes any numbers that target egress gateways or Unified
CMs.

Step 4 Perform the following steps to configure ingress gateways, VXML gateways, and Unified CMs.

a. Configure the gateways to support SIP in general. It is not necessary at this point to disable
H.323 in general or to remove gatekeeper registration settings.

b. Configure each ingress gateway outgoing VoIP dial-peer to use SIP rather than session
target ras. If SIP Proxy Servers are being used, configure these dial-peers to target those
servers. If not, then configure these dial-peers to target one or more CVP Call Servers.

c. Configure each VXML gateway incoming VoIP dial-peer to be a SIP dial-peer.

d. Configure Unified CMs such that ingress gateways and Proxy Servers are SIP Trunk
devices.

Step 5 Try some test calls. If the tests are successful, perform the following steps to remove H.323
support.

a. In the CVP Operations Console, remove H.323 services from each CVP Call Server.
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b. In the ingress gateways, remove H.323 support as well as any settings that cause the
gateway to register with the gatekeeper.

c. Decommission the gatekeepers.

Migrating from Tomcat to WebSphere Application Server

If you want to migrate your CVP VXML Servers from a Tomcat platform to WebSphere
Application Server, perform the following steps.

Step 1 Uninstall VXML Server from the Tomcat-based machine, or reformat the disk and reinstall the
Windows 2003 operating system.

Warning: If you decide to reformat the disk and reinstall the operating system, and Call
Studio is also installed on your machine, back up any application projects before you
reformat the disk.

Step 2 Install WebSphere Application Server.

Refer to your WebSphere Application Server documentation for installation procedures.

Step 3 Install VXML Server from the Unified CVP Software DVD. See Installing Unified CVP Software
on Windows Systems (page 19).

Step 4 Use the Operations Console to configure and license VXML Server.

Step 5 Use the Operations Console to deploy all applicable projects to the new VXML Servers.

See Also

For details on Steps 4 and 5, see the Configuration and Administration Guide for Cisco Unified
Customer Voice Portal.

Adding Reporting or ICM Lookup Capability to Standalone VXML Server

Standalone VXML Server deployments prior to Unified CVP 4.0 did not include Unified ICME
components. In these deployments, applications are invoked as a direct result of calls arriving
in the VXML Gateway, and a single post-application transfer is allowed.

In Unified CVP versions 4.0(x) and later, you can select the VXML Server during installation
to add reporting or ICM lookup capability. Unified ICME integration with VXML Server is
nominal. Refer to Operations Console Online Help for Cisco Unified Customer Voice Portal
or the User Guide for Cisco Unified CVP VXML Server and Cisco Unified Call Studio  for more
information about CVP VXML Server.
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Troubleshooting Unified CVP Software Installation
This chapter describes how to resolve problems you may encounter while:

• Installing Unified CVP software and performing the initial configuration.

• Upgrading Unified CVP software.

• Uninstalling Unified CVP software.

This chapter contains the following topics:

InstallShield Engine Cannot Be Installed

Symptom:

During Unified CVP installation, the following error message displays:

Message:

The InstallShield Engine(iKernel.exe) could not be installed. Ikernel.

exe could not be copied to C:\Program Files\Common

Files\InstallShield\Engine\6 \Intel 32.

Cause:

Multiple instances of the Install Program are being run.

Note: InstallShield (the install program for Unified CVP) allows only one ikernel.exe to be
running at a time.

Action:

Stop all install programs and run the Unified CVP installation program.
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Reporting Password Error During Installation

Symptom:

When you specify the Reporting password during Reporting installation, you encounter the
following message:

Message:

Error 2245 while running: changing default password for user Informix

Cause:

The password security policy on the machine on which you are installing Reporting conflicts
with Unified CVP Reporting password requirements. Most likely, the machine password security
policy has a minimum password age greater than 0 or the maximum password length is greater
than the maximum password length that Unified CVP Reporting password requirements permit.

Action:

On the machine on which you are installing Reporting, abort the installation process. Open the
Local Security Policy control panel (Control Panel > Administrative Tools > Local Security
Policy) and examine the Password Policy (Security Settings > Account Policies > Password
Policy). If the password policy on your machine conflicts with Unified CVP Reporting password
requirements, make the appropriate adjustments. Restart the installation process. If it is not
possible for you to make the necessary adjustments, or if problems persist after you make these
adjustments, consult your Network Administrator.

Installer Does Not Continue Past the Select Directory Screen

Symptom:

The installation process will not let you continue past the Select Directory screen.

Message:

<DIR> currently contains data. Unified CVP will not install to a

directory that already contains data - please select another directory.

If this is the correct directory, then cancel the install, remove the

directory and re-run the Unified CVP installer.

Cause:

The directory you specified contains data either from a previous version or build of CVP or
another program.

Action:

Verify that the directory you specified is correct.
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• If the directory is incorrect, specify the correct directory.

• If the directory is correct, click Cancel, remove the directory, and rerun the Unified CVP
installer.

Error Uninstalling WebSphere Application Server

Symptom:

You encounter an error condition when you attempt to uninstall IBM WebSphere Application
Server

Message:

Several possible.

Cause:

Several possible.

Action:

See the CVP Installation log for details and instructions.

See Also

Consult the IBM WebSphere Application Server documentation and support website.

Dialog Box During Informix Uninstallation

Symptom:

If you are uninstalling Informix Dynamic Server, a dialog box with the following message
displays during the uninstall process:

Message:

Could not delete product files and/or directories. Check documentation

for more details.

Cause:

This message is benign; it does not indicate a problem with the removal of Informix Dynamic
Server.

Action:

Click OK to continue the uninstall process.
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"Informix Detected" Message During Uninstall

Symptom:

When uninstalling Unified CVP on Windows 2003, you get a dialog box with the following
message:

Message:

"The Informix database, installed by the Reporting server, has been detected on this system.
You must uninstall it before re-running this installer or change your package selection."

Cause:

You attempted to uninstall Unified CVP without first uninstalling Informix.

Action:

Cancel the Unified CVP uninstall, uninstall Informix (see the section Uninstalling Informix
Dynamic Server (page 36) for instructions), then uninstall Unified CVP.
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